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Administration

P

iSeries Abcess for Windows V5R2

New Redbook for administering Hot TOpiCS:
iSeries Access for Windows Tailored |mages, App"cation
users Administration, SSL, and Kerberos
— SG24-6939

— Available Feb 2004

‘Speeding up your multiple workstation install
using 4 tailored image

Go out to iSeries Access for P
Windows web page kit o

— www.ibm.com/eserverl/iseries/ .~

Securing your conections with

aCCESS/WindOWS 5L and Kerberos single sigh on 5 | .
— Click on New Redbooks link /
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V5R3 changes

 iSeries Access for Windows (5722-XE1, V5R3) will not install on
Windows 95, 98, Me

» However, you can use 5722-XE1 (V5R2) client for Windows 98 or ME
PCs and connect to OS/400 V5R3 or earlier

» You can use 5722-XE1 (V5R1) client for Windows 95 PCs and connect
to OS/400 V5R3 or earlier

» Note: The 5722-XE1 (V5R2) client will install on Windows 95 PCs if you
first go to Microsoft website and install the TCP/IP Upgrade on your
Windows 95 PCs. (unsupported environment)

e Migration from AS/400 Client Access for Windows 95/NT (5763-
XD1, V3R2) is no longer supported

e Upgrading from AS/400 Client Access Express (5722-XE1, V4R4) is
no longer supported

©2005 IBM Corporation Why “i"? it's Simple.




IBM eServer iSeries

Installing, Updating, Managing

iSeries Licensed Program —
Product No. 5722-XE1

Three versions
currently supported:
V5R1MO, V5R2MO,
V5R3MO

© 2005 IBM Corporation Why .i-? it's Simp|e.
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iSeries Access installed in iSeries IFS

iSeries Access client Install Image placed in IFS in:
— \QIBM\ProdData\Access\Windows\Install\lmage

iSeries Access Service Pack placed in IFS in:
— V5R1 - Service Pack PTFs saved in the main install image--no extra

reboot! 6
— But is likely to not be latest Service Pack available \—4 |

iSeries Access installs and services other products as part of its install
from IFS
— SSL Encryption Program (V5R3), iSeries Toolbox for Java, Java
Runtime Environment, iSeries Navigator, EZ Setup

iSeries Access can be used to install and service other code placed in
IFS:

— iSeries Navigator Plug-ins, Add-ins

PC CD also shipped with the product ’@\7
— V5R2 - Can create Customized Install CD images \1/

SNB

&

%
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iSeries NetServer

iSeries
- NetServer
_ Shared

If installs are Diectory

done from

QIBM \A

directory, end

users will \QIBM\ProdData\Access\Windows\Install\Image
automatically

get new * QIBM ships with a “read only’ share
service pack access

fcotde and e Thus, all users can access iSeries Access
uture for Windows code on the iSeries
upgrades

when new

code placed

on iSeries

‘o
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Service
[Faias Kecass for Windows Peaparies 2]
Ganarl | Passwords | Hm::\:v:m | Language |
Strategic way to handle b e
. Whin 1o check senvice lavel
service for end-users i s3]
Chasck service lavel on! Wﬂ
. Hest chack =
— Automatic Check L ﬁg’”‘
Service Level Lo hacked w7200
fratal Opiicrs.
7 Poarform shert matalston
H 7 Copy rutsl image o PC belors natsling
— Check Service T
Level can also WFrdea A B ot imoge =] __bowss.. |
service: /
ok | cees |
. |Ser|gs Navigator Note:
Plug-ins
* Encryption In example above, there was a Mapped Drive to
Program (SSL) W:\\<iSeries>\QIBM, so iSeries Access for Windows filled
in the rest of the address.
Could also use service Source Directory of
\\<iSeries>\QIBM to avoid assigning a persistent drive
letter mapping
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Install and Service Pack Tips

Make sure you have the latest Service Pack before rolling out
new installs
* Roll out new clients from merged image and get new
release and latest service pack in one step p
(@)
~ O 18

* Merged install image eliminates the need for an extra
/\
O
[5R

reboot

— Save disk space on PCs

« If a Service Pack has been well-tested, and you are
confident in it, you can have your end-users install it
without enabling service pack uninstall.

e This eliminates the need for an \Archive directory
containing files from the previous service level.

* RMVPTF and reinstall from install image could be used
to get back to the prior service level if necessary.

© 2005 IBM Corporation Why "i"? it's Slmple.
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FTP Service Packs for Testing

Suggest using FTP download for
validation testing e

Latest Service Packs for Supported Releases

wrloading a service pack, click hare.
formation on iSeries Access and the Microsoft Windows operating

* Don't place downloaded
Service Pack in the iSeries o o
LPP (QIBM directory, ie, fccess sorvor [ 02097 | sputatioa
\Install\image) because: o

for
VERIMO | and iSenes Navigator. 1f | P ie | ene 29 0g 0c 0008

H 1 H s ontains fixes
1. It will interfere with APYPTF Wacagemant Sns¥ | tore vo J—
30, 2008
2. Check Service Level (by [
default) looks in the QIBM [| Vvshamo 5116915 gacia ok
directory for updates JaiSKinG 511180

Rafar to May 12, MNovambar
. 2005 | Owraerez | MR

AR | 05/08/01 | Mot in plan

Problems downloading a Service Pack?

: Plac_e in_ another directory in http://www.ibm.com/eserver/iseries
the iSeries IFS or on another Jaccess/casp.htm
server or on single PC
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Get fixes from IBM
Order Service Packs through normal IBM channel

and install on the iSeries

iPTE Siaiss cooaod s
! VERIMG fu'gmm;ﬁ"?: “"'""' .:;:i" 06/05/2005 S;:“';m
« Internet PTF - will send you a CD ratid S,
because image is too big to T
download over Internet. wawo | s | WA M | wmer | ST
VRIMO | SLL006 ) "‘;’"u;“ UHOA0L | Notin plan
SNDPTFORD
. Try ona of thase:
« Send PTF Order - will send you a _ _
. . . & Révlw mﬂﬂalﬁmnm&mkmlﬂ. Probiems Downigadog Hles from the
CD because image is too big to EL St nchang Cheor sctezs e facs
download over Internet -&o‘:"s::':;i::!::::dﬂvu;n?:j;mr1?.??!?!:1111"“‘ it on your iSanat.
Since the service patk PTFS generally excasd the size mit 2o be sant
B S,
o “LINKONLY.)
C;‘“"T_APES — N T M ot e e e
« Service Pack included on o, sict T’

CUMTAPES too, but may not be
the latest one available

© 2005 IBM Corporation Why "i"? it's Slmple.
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New Feature in OS/400 V5R2...

Use IFS as a Virtual Optical Device

Install the Operations Navigator plug-in
— Required one time only if you choose to

« You can obtain a Service Pack CD download using Operations Navigator
electronically and place it directly in + Download the self-extracting .exe file
the IFS in a Virtual Optical Device — Run the .exe file and install the files in the
(just like a real iSeries Optical default directory:

Device) « jvopnav\com\ibm\as400\opnav
« Consider using software managers called

» You can then download a CD image "download managers" to allow you to
of the PTF and make your IFS look resume interrupted or failed downloads,
like a CD Drive eSS

— GetRight®

+ You can install the PTF from this CD - Codie
image thus eliminating the need to — Netzip
either use: — SmartDownload

— iPTE » For more information, go to:
— SNDPTFORD — http://www-912.ibm.com/

supporthome.nsf/document/27321011

This option of ordering the official Service Pack PTF may be a more attractive alternative
than downloading the Service Pack PTF from the iSeries Access webpage

©2005 IBM Corporation Why “i"? it's Simple.
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Install and Service Pack Tips

Keep end-users from installing a service pack until you are ready

* Text file SP.TXT placed in the service pack image directory
can prevent anyone from installing the service pack until you

— "Y' or no SP.TXT file at all will allow the install
Second text line can contain a message to users that will appear
during Check Service Level

* Same method used to prevent all end-users from upgrading
via Check Service Level to a new release

« Additional control values for a merged image:
— 'U" allows an upgrade, but stops a service pack
— 'S' allows a service pack, but stops an upgrade

Documented in User's Guide - look in Index for 'SP’

are ready i@
— 'N' as the 1st character in the file prevents install i 'i
1—’

5
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Installation Options
— Typical
+ Not best option, as much LI
of iSeries N avigator gets Select the type of installation by pressing ane of the buttons.
installed -
Typical
Installs required programs and most
components. (License required)
— PC5250 User
. PCE250 User
° On |y 5250 emu Iat|0n Installs required programs and 5250 Display and

insta| |ed Printer Emulator. [License required)
Custam
*f'ou may zelect which companents to install
- Cu stom (Typical components are pre-selected ]
* Best option, but most -
CcO nfu Si ng Installs all components. [License required)

— Full
* Installs everything

< Back I Hest> |

Cancel

* Has new meaning with
Tailored Install function

© 2005 IBM Corporation Why i"? it's Simple.
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Installation Types

1. New installation of iSeries Access for Windows

— If done from the iSeries using iSeries NetServer, iSeries Access for
Windows automatically sets end-user up properly for later service packs
and upgrades

2. Upgrade Install
— From one release of iSeries Access for Windows to the next release
— Intend to always support N-2to N
— Default is to upgrade to new release with same set of components
— Can add additional components during upgrade
— Can remove existing components during upgrade process

3. Re-Install same release
— Functionally very similar to upgrade install

— Will install over a service pack level, returning end-user to same level as
installation image

©2005 IBM Corporation why ""? it's Slmple.
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Install and Service Pack Tips

C,
iSeries Netserver tgﬁ

Guest User profile oY%
iSeries NetServer Advanced Next Start - Commondenver 7] x|

— For users th at |BM iSeries Support for Windaws Network Meighborhood
normally do not

. (Guest user D nsgues
have access to this
iSeries - but yOU Coded character set D 0 - Use iSeries MetServer CCSID Erowse...

wish to giVe them Il time-out far inactive session
access to client # Disconnect sessions: 6000 seconds v
code or service 1 Leave semions connected
packs
Browsing annauncement interval a0 v | |seconds i

Reset to Curent
ok I Cancel | Help |

©2005 IBM Corporation Why “i"? it's Simple.
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S

Perform Install for your
users

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Tailored
Install

©2005 IBM Corporation Why “i"? it's Simple.
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Tailored Install

Windows components your users install?

You can use Tailored Install to:

« Create a custom installation
image by excluding the
unwanted components from a
master installation image.

¢ Use this customized
installation image for
installations across your
network

» Users can easily install iSeries

Would you like to control which iSeries Access for

Create Tailored Installation Image

waumwmﬂuﬂmﬂmnmmhm
usess can instal only those components you want them to install.

By defau, ol components vl be included in the installation
image. smwhmmmmmm

Itheu.lakaakLaw[SSL]amnauaiahla the 551
awutcanbamhdadnhlaimdm.agn

Access functions by selecting
a single option

© 2005 IBM Corporation
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Find Tailored Install Wizard

why “i"? it's simple.

Steps to set up your own 'Tailored' Install

© 2005 IBM Corporation

Lot A | ‘ \g:earcn ‘lﬁmlﬂers té"hu Wl ‘ e
* Stored in Client s |D i ProdDatal 40D Express st Image
Access folder
Folcers X |Name ! | Size|Tpe |Modiﬂed |
Egmhmnume‘,‘i'ﬁu * j AUTORUN.INF 1KE Sehuplnfomaton — 2/20/2002.8:50 M
QIBM-> 80 e REate LU4KE. CabireFe g0 205
ProdData-> B0 ks HBUSEL R HIB HRFl 6152005 25PM
CA400-> 401 s S 576518 Cobnet e 24442
Express-> B0 hess e HASEARILHR BB HORFie 240
20 cmn | CWECOMSG‘DLL 56 B Appluation Extersion  4[24[2002 4:42 A
Install-> B o &l e 148 Confiatin ettngs 6f32003 2060
Image-> ED il Boumen JUE6E Widows nsteler B, 6182005 2062
B |[Mowmeo BH5HE  Agplcehin Eoersin 2120/ 2002 659
- ) R i) 1B HEOOSBAFE 20 B A
* Start Cwbinimg.bat 80w B cvmme s TN temet Commuriz 2020/2002 53
program AR ] CHERES 1L S0 AgplcehinEoerein 40412002 42
TREY - ﬂlcwamsn BE IA04E Aplcston R

why “I"? it's simple.
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Run Wizard to create a Tailored Install Image

Run Tailored
Install wizard

We wil create the tailored installation image in the following
diectory.

Ta create inthis diecton, press Newt.

Tocreate in a different directory, press Browse.

Select where you want this

saved
Ir DestinationFolder ——————————————————————
o 2Maiored nstallimage
» Could be in iSeries IFS or PC server... -1
<Back | Mets | Cacdd |

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Example

Only want to provide ODBC and Printer Drivers for some of your users

" Build tailored install x
th aton ly.en ab I eseén d Select the components pou want ta install. Deselect the companents you want ta
users to install only “ exclude
ODBC and Printer
drivers Components Size| License Requied &

[ Bz Data Transfer 0K v
@ ODEC 298K
* Deselect all items you L] & OLE DB Provicer oK
. y | I—|:| @ Lotus 123 File Format Support \ 0K J
don't want users to 1 42 AFP Workbench Viewsr 0K
use. Program will tell —Dg%olboxrowava 0K
f : BH] (Rl 5250 Display and Printer Emulator 0K v
you if there |S.a pre- EH] @8 Secure Sockets Layer (35L) 0K
req you must install -7 & Frinter Diivers 314K
[ PR S iy nv _Iﬂ
4 »

* Note: this option
requires 23MVB of
space. Help | < Back I Newt » I Cancel |

© 2005 IBM Corporation Why “"? it's Simple.
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Use Full Install option

Users now simply: e

* Point to Folder where your
Tailored Install is

Ta add a component, select any companent that is currently not
selected

FRemoving components:

Ta remove & component, deselect any component that is
cuirently selected, You wil be asked to confim the uninstal for
any companents you selected before the uninstall begin:

 Click on ‘Setup.exe’ to start the
iSeries Access for Windows
Install Program

T Tupical
Installs required programs and most
A components. [Licerse required)

* Then simply select 'Full' install

— Users get only the functions
you created in the Tailored
Install

PL5250 User
Installs 1equired progiams and 5250 Display and
Piinter Emulator. [License required)

Custom
You may select which componerts to install
pical components a ed)

Note: If stored on iSeries, can use
i5/0S authorities to restrict users or
groups from install images that

they should not be el [[car | s Cancel
installing/upgrading from

Full
Installz all components. [License required)

© 2005 IBM Corporation why " it's Simple.
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Servicing the Tailored Install Image

Problem

— When you create the Tailored Install, the Program Temporary Fixes (PTFs) in the
QIBM directory are also applied to the newly created tailored image.

— However, this tailored installation image is not updated when future PTFs are applied
to or removed from the iSeries server

— Because they are in a file unknown to OS/400

Solution
1. You can recreate the Tailored Install image by pointing back at QIBM, re-running
Tailored Install, and storing on top of your old image.
2. Go to iSeries Access web site and download PTFFORM. This can be used to your
Tailored Image.
* Only updates to functions in your tailored image will be updated. Thus users will
not be able to run Selective Install and get additional Access for Windows functions
from that directory.

For information on Tailored Install images see:
— http://publib.boulder.ibm.com/pubs/html/as400/infocenter.html

— Find 'iSeries Access'. Then follow path of 'Administration’, then 'Installing or migrating multiple
PCs', to 'Tailored Install'

©2005 IBM Corporation Why i"? it's Simple.
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PTFFORM

Use PTFFORM to add new Service Pack to

Tailored Install image

SI17742
Replaces 5117411, If
V5R3MO you have installed
5117411, refer to the
service pack readme

Refer to
Server Notes

April 1, 2005 | 03/04/2005  June 24, 2005

ety Referto | November 17
1 '
VIRZMO ‘ 5116136 S Notes 08/09/02 | May 13, 2005
1 Refer to . :
VIR1MO ‘ 5111806 i ADrIlED,ZUM‘ 05/08/01 Not in plan

www.ibm.com/eserver/iseries/access

PTFFORM
only puts
in fixes for
code that
is
contained

in Tailored

IBM eServer iSeries

© 2005 IBM Corporation

Tailored
Install
with
iSeries
Access

for Web -
Download
function

Install
image

why “i"? it's simple.

© 2005 IBM Corporation Why i"? it's Simple.
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Downloads — for file/program distribution
http://<myiseries>/webaccess/iWAPackages

programs to users

« Mechanism to distribute files / BT R Accesfor Hater =2 |

s Dtsbane) rwrw e coes esrver erien soceny windowy

Veewer g

V5R3 shipped view

Check this out at http://iseriesd.dfw.ibm.com/webaccess/iWAHome,
Userid = BOATADMIN; Password = DEMO2PWD

© 2005 IBM Corporation Why "i"? it's Slmple.
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Example of how you might use this function

e Scenario

— I have some users who need the ODBC driver from
iSeries Access for Windows. What would be an easy
way to make this available?

» Solution

— Use iSeries Access for Windows to build an install
image that contains only the ODBC drive

— Use iSeries Access for Web to enable users to install it
on their PCs

©2005 IBM Corporation Why “i"? it's Simple.

« Administrator can create s
downloads Name Detcrpaon L Soe Action
« Management functions e N ey - Lo ad
. . b o o e e
included for updating Seis et o 100 Sk $10 180797 Devsnd
. LimPR0)  diher For soer idomaion e Tpenm
downloads and for controlling e o ke i
Berien Acrem for - eries Accest for Windows ODBC dver, Mot provider, and Duta Tranlr For SeriesAcrens-D8- 16,235 114 Pospload
access to them Vb o e o v bmcm ke $30516
mmu et Aceen for Wiasdows 114) camlater snd print deiey. For sore: Deacidcien 16,613,313 Dewnload
Windomy nformsion wee . wars b com meny e s v PCRMO-S38-
-y pesasy EIEEEY
Access for Water == n Beries Access for - Beries Accest for Windows 1140 comduer, prioe dvens, O0BC dover, Nt Beriesheocens. 14,506 524 Downbond
—— Windows PO poovidie, o D Traeses: For mmore iformtion pex: POSER-DB00-

SIS e

Vnkwi AR TheAFP Vieww php-i bt o view AFF oot Wb biomoer. pgildmens 9997972 Did

Users can download Access for Linux
and AFP Viewer Plug-in products

2

@,
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Create Tailored Install Image of ODBC driver

Create Tailored Installation Image

Ew default, all companents will be insluded in the installation
image. Simply deselect the components pou want to exclude.

If the Secure Sockets Layer [SSL] support is avalable, the SSL
support can be included in the tailored image.

“'ou can create your own tailored installstion image so that wour
users can install only those components you want them to install

You just used
iSeries Access for
Windows Tailored
Install wizard to
capture only the
Windows ODBC

IBM eServer iSeries

driver
‘Component Selection
Select the companents pou want to install. Deselect the components you want o
H exchide
Compaonents Size| License Requied ~
B Required Programs 16048 K] E
B B Optional Companents 0K,
B[] @ iSeries Navigator K]
EHV dab Data Access 4K
[ B Data Transfer 0K, v
&y 0DBC 4K
[ 3 OLE DE Provider K]
[] %2 MET Dats Provider K]
|| 17 k] Lotus 123 File Format Support 0| ™
(= B R T — v
<] [2]
Diive: [: Space Requied: 16M Space Available: 58823 M
Help <Back [ Hewt> | Concel |

© 2005 IBM Corporation
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Use the ‘Create Download’ feature

» Use iSeries Access for
Web Create Download

to make a file
available for
distribution

» The file is copied to
the server on which
iSeries Access for
Web is running

» After the download is
created, it is added to

the Downloads list.

iSeries Access for Web

# Une Create Dowsload 1o make 3 fle svadable for davibasion. The e is copied 1o the server on witich iSeries Accen
for Wb bs runmsing. Affer the download bs coeated, it is adkdend o the Dvmmdoads st
# When n downdoad s eovated i ca only be aceessed by the user who coeated # and by wers with *SECADM

Create Download
= Name  OOBE Dever VEAD
Miapn | Descripion: D0BC Dwwar VERY
f o | e YIOBCVSRIm
£ |
Dwstair [y v——y |
o L e Gomions
Command |
Dewrlaat | Create Dowalead Detads
Dowsiindy
Twsine
e by Uite the Woek wih
Haluee Links: wabable 10 other woen

© 2005 IBM Corporation

e e Diomloads Bt s select e Massge Acess ik 15 mabic the & "

why “I"? it's simple.

15



IBM eServer iSeries

ODBC now added to Download List

* When a download
is created, it can

8\t Folder Downloads .
only be accessed ===
by the user who i woe
H Messages
created it and by = } Name Description File Sz Action ©
users with 29 | 04_08_03_hwyS2.tm 22,737 Dowiload
: Work
: Database —aE
*SECADM authority |2 : i
o] | iSeries  iSeries Access for Lim contains a full 5250 iSeriesAccess-5.2.0-143860pm 3,315,790 Dowaload
iz Access  emnlator and an enbanced ODBC diver. For Work
i Vet iformaton ith
: for Linx more izformation see with
s Use the Work with | o 0 om s
action from the o {Series  iSeries Access for Linx contains a fu 5250 iSeriesAccess-5.2.0-14pperpm 3,507,997 Dowiload
. i | Access  xnltor andan enanced ODBC civeFor Work
Downloads list and [T —— it

(PPC)  https/www.ibm.com/eserver/fiseries access/limu/.

ODBC  iSeries Access for Windows - ODBC Driver ~ ODBC Driver for iSeries VSR3.zip  14.637.675 Download
Driver  V3R3 Work
V3R3 with
PC5230 PC5230 Emulator V5.8 (V3R3) PC5230 Exmulator VSR3.zip 38,946,701 Dowload
Work

Ceater .
{Series Resoutce Libtary sith

select the Manage |
Access link to :
make the download
available to other
users

why “i"? it's simple.
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Work With Download options

« Edit Name and Description — -
iSeries Access for Web

* Update File ) ) B gy Folder Work With Download
— The new file will replace

the current file that is : Neme:  ODBC Driver V5R3
available for = | Description: iSeres Accessfor Windows - ODBC Defver VER3
downloading. s | Fie ODBC Driver for iSeries V3R3 zp
— The current file will no 5250 | Size: 14637673
longer be available to Database | Last opdated: Jun 28, 2004 90522 BM
download. Flis |
Command \Acﬁnn
Download \
e Delete Downloads ¢ Edit name and description
Create download ¢ Update file
Customize
» Manage Access : L -
Other |« Manage access

— This action enables you
to either give or deny
access to users.

©2005 IBM Corporation Why “i"? it's Simple.
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Manage Access to New Download File

e Set up who can access
new download file

— Deny Access defaults
to only the creator of
the download can
access and manage
this download

you wish to access it
e Can be All Users
(*PUBLIC), groups
of users, specific
users

Poet
Messages
Jobs
250
Database
Files
Command
— Now select the users Dowrioad
Diwmieads
Cisate dowload
Customare
Other

— Set who else can
manage this download

© 2005 IBM Corporation

iSeries Access for Web

Manage Access

Name: ‘ODBC Driver VSR3
| Description: #Series Access for Windows - ODBC Driver VSR3
| File: QDB Driver for iSeries VSR aip

| Size: 14,637,678
| Last updated: Jun 28, 2004 9-05:22 PM

i Allow Access Deny Access AMamage

cminer [

why “i"? it's simple.
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Download and Install ODBC on Desktop
« If you had originally
zipped up the Tailored Devaionds .
Install directory using é_n wooow
some product like Install = f o g e e

Shield's Package For the
Web, then it would
initiate the install for the
end user.

PR

P
P
a—

o e
fr—
-

s a
o

for Windows, so | have
to go into the directory
and start the install by
pressing on SETUP.EXE

| i
| Acirsa  emmbabor sl b COBC tren. Fo
[ e

Do Eorwies Adwus o Limis commmie 4 B 4340 [irndecesad 100 dppeapem 80787

T —— e
[ ——————

Here | had used PKZIP L=

orwies Arcess i Limes vostaios NI 9350 embendevess 4 20-0 4000 pm 131500

: A b it Com CUAE C e S 470

© 2005 IBM Corporation
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IBM eServer iSeries

Silent Install

Can be used for:

=|nitial Install

=Upgrades to a new
release

=Service Packs

Silent
Install

©2005 IBM Corporation Why " it's S|mp|e.

* A way to restrict the set of initial
components that an end user receives

» Allows you to quickly and easily copy
duplicate installations across your
network

* Eliminates the need for end users to
have to respond to any prompts during
the installation process

» Can be used for upgrades, selective
setup, and service packs.
Upgrades and service packs should
launch setup.exe from the install
source.

— Selective Setup should launch
setup.exe from the PC's ...\Client
Access director

©2005 IBM Corporation Why “i"? it's Simple.
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Silent Install

Silent Install indicator

e Appears in task tray on
end-user's PC during
silent install

* Silent install failure
leaves indicator active

* Double-clicking indicator
shows failure point

© 2005 IBM Corporation

IBM eServer iSeries

Access web page at:
www.ibm.com/

22 iSeries Access for Windows Silent Install 5105853 1 ]

iSeries Mavigator Base Support: Copying files...

Silent Install 462 Complete

Really silent!

why “i"? it's simple.

Center from sidebar

Or go to:

=]
Silent Install Documentation
Detailed information on Silent W u&?
Install is on the web in the IBM Ou-0 B30 Pt @@ BB E-U0
iSeries Information Center B i o] v
e« [T e+ i e Wit ot [t D - D
Get there by going to iSeries i s :
Wi [re——— ]
e ho T
eserverfiseries/access/ windows, :?;"iﬁ:g&,““*“m“m
o e v ey o
then select iSeries Information
Sdewt mital it
iy o v ol
sl 5 complete The » . drd ‘-Lttl
Cick o he ool gl 10 3 e e meiage
http://publib.boulder.ibm.com/ Yo
pubs/html/as400/ infocenter.html o ’ vt
f 0 |

Search on Silent Install

© 2005 IBM Corporation
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Using Silent Install

Create aresponse file

* Aresponse file records the selections made in response to the prompts in
the installation process.
* You perform the desired type of install on your PC, recording installation
choices into install scripts (.iss files)
— For example, setup.exe -r -f1C:\MyDir\v5r2v5r3upg.iss

Start the silent installation

« During a silent installation, the setup program will use the response file to
get the information necessary to complete the installation
* Schedule or run setup.exe on the end-user PC's with the proper parameters
specifying the response file location (or use CheckService LeveISJ
— For example, setup.exe -s -f1\\iSeries\Express\Response\v5r2v5r3upg.iss -
f2C:\Temp\v5r2v5r3upg.log

Check the log file return codes to see if your install was successful

* The Log file tracks installation results. You can specify location/name of the
Log file

« Silent.txt file in the ...\Client Access directory lists the components installed
silently and successfully

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Check Service Level for Silent Installs

Cliant Access Properios

Use this for Service Packs —
and Upgrades Genral | Passwords | Langunge | Dingnostic Taoks ce | other |
Lo . ‘When to check: ]m
Eliminates Fhe need for confusing T —— it
command line parameters, but N —— e e
does require s_pecmc names for Nmberominses odoley. [ ]
the response files e
*SLTSP.ISS - for service packs e cnses——
(This file must reside in the I Copy il imame 1o PG bofore (sl
same directory as the service Snurce Directary:
pack image) [vicomment taibm = Ll
*SLTUP.ISS - for upgrades
(This file must reside in the ok | cencel | appty |
same directory as the upgrade
image)

«If rebooting automatically, consider using SCHEDCHECK parameter on cwbckver.exe and
schedule during the middle of night. Look in online iSeries Access for Windows User's
Guide index for cwbckver for more information on the SCHEDCHECK parameter

«If not rebooting automatically, Check Service Level will come out of silent mode and prompt

user for reboot

© 2005 IBM Corporation Why i"? it's Simple.
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Errors using Silent Install

Most silent install errors involve a dialog out of order from what
was recorded (-12 return code in silent log)

* The best way to debug this is to start a manual install on the
failing PC and proceed through the install wizard panels until
the confirm panel prior to file transfers

* The majority of the dialog errors occur prior to the
confirmation panel

» See if any unexpected dialogs appear that were not
anticipated during recording

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Silent Install Upgrade and Service Pack Install Tip

Use Incoming Remote Command component of iSeries Access for
Windows with Silent Install Upgrades or Silent Service Pack Installs

» Start service on NT/2000/XP/2003 client

— Specify to log on as Local System Account to satisfy Administrator
authority restriction needed for install

— No need to "Allow Service To Interact With Desktop" for a Silent
Upgrade or Service Pack Install

« RUNRMTCMD on iSeries specifying setup.exe/setupsp.bat and
userid/password of Administrator account on PC
— RUNRMTCMD
CMD('w:\proddata\Access\Windows\install\image\setupsp.bat -s -
fl\myserver\silentshare\sltsp.iss') RMTLOCNAME(PCNAME *IP)
RMTUSER(PCUSER) RMTPWD(PCPASSWD)

« REXEC from a TCP/IP client can also be used to submit setup.exe

©2005 IBM Corporation Why “i"? it's Simple.
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Combine
use of
Tailored
Install
with
Silent
Install

~ function

©2005 IBM Corporation Why " it's S|mp|e.
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Combine use of Tailored and Silent Install

* You wish your users to:

— Have only selected parts of iSeries Access for Windows installed on
their PC

— And you don't want them to find additional Access for Windows
functions in the Selective Install windows

— Get it installed on their PCs without user intervention

— Want updates (service packs) and new releases to automatically get
installed on those end user PCs

* Use a combination of Tailored Install and Silent Install and a few PC
commands (wizards) to do this

e From then on Access for Windows will keep desktop users up to date.

* Use new PTFFORM to update Tailored Install directory with fixes §

Steps to perform...

©2005 IBM Corporation Why “i"? it's Simple.
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Create Tailored Install Image of ODBC driver

Create Tailored Installation Image You just used
iSeries Access for

“You can create pour own tailored installation image so that your

users can install only those components you want them to install WI ndOWS Tal I Ored
By default, all components will be included in the installation .

image. Simply deselect the ComPaments wou want b sxclude. Install wizard to

If the Secure Sockets Layer (S5L] support is available. the SSL capture on Iy the

support can be included in the taiiored image

Windows ODBC
driver

Component Selection

“ Select the components you want ta install. Desslect the componshts you want to
exciuds

Size| License Requied A

Fiequired Programs 16042 K] =
-] B Optional Components i
B @) iSeries Mavigator il
EHW] € Data biccess 4K
[ B Data Transfer K| v
&g 0DEC 4K
33 OLE DB Provider k|
[] 42 .NET Data Provider 0K
=] l& Forrnat Support ] Ok [V
= @ e o]
[ m| =
Drive: T: Space Requied: 16M Space Avaisble: 56823 M
Help <Bsck [ Met> | Concel |

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Step 2. Record Silent Install of the Tailored Install Image
mmand Prompt

Microsoft Windows 2BBA [Version 5.8M.21951]
<G> Copyright 1985-20088 Microsoft Corp.

C:s>N\myiseriessmysharestailorUS5R2Nsetup.exe —r —fls\myiseries mysharestailorUSR

2smytailored. issy

» Do not have any version of Client Access or iSeries

Set up to Access (5763-XD1, 5722-XE1) on your PC

.record ! » Point to QIBM directory on your iSeries
Silent Install . . .
Point to location you want to store your response file
Response (not in QIBM directory)
File » Bring up a command prompt

Using ‘universal » Key in Silent Install command
naming convention
S}J;‘)‘;i)ng‘g‘zfriaa[‘so — 'setup -r -f1d:\dir\file.iss' to identify where
it can be found responses are to be stored

ithout a mapped
‘grliveu PP » This starts the iSeries Access Install program

© 2005 IBM Corporation Why “"? it's Simple.
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Recording the install of Tailored Install folder

Now select 'Full' install to
capture steps to install
everything that is in the
Tailored Install file

Type of Installation x|

Select the type ofinstallalon by pressing one of the buttons,

Typical
Installs required programs and most
components. [License requited)
PC5250 User

Insialls requred programs and 5250 Display and
Priter Emulator (Licsnse requied]

g g Custom

e You may selzct which components (o instal.
g (Typical componens are preselected )
gg Ful

2 Installs all avalable companents. [License
u equied)

e, Cancel

Note: during this step this image
is also being installed on your PC.
You probably want to uninstall it
after completing this step.

IBM eServer iSeries

©2005 |

Step 3. Schedule Silent Install for PC Desktop

ommand Prompt

Microsoft Windows 2080 [Version 5.80.2195]
<C> Copyright 1985-2880 Microsoft Corp.

IC:\>help at

The AT command schedules commands and programs to Pun on a computer at
a specified time and date. The Schedule service must be running to use
the AT command.

AT [“~computername] [ [id]l [-DELETE] ! ~/DELETE [~YES11
AT [““computername] time [~-INTERACTIIUE]
[ /EVERY:datel....1 | sNEXT:datel,...1] “command"

“S\computernane Specifies a remote computer. Commands are scheduled on the
local computer if this parameter is omitte
Is an identification number assigned to a scheduled
comnand .
Cancels a scheduled command. If id is omitted, all the
scheduled commands on the computer are canceled.
Used with cancel all jobs command when no further
confirmation is desired.
Specifies the time when command is to run.

~interactive fAllows the job to interact with the desktop of the user
who is logged on at the time the jobh »uns.

vevery:datel....]1 Buns the command on each specified day(s> of the week or
month. If date is omitted, the current day of the month
is assunmed.

nextidatel,. ... 1 Buns the specified command on the next occurrence of the
day (for example, next Thursday>. If date is omitted. the
current day of the month iz assumed.

"command" Is the Windows NI command. or batch program to he »un.

+ Bring up Command prompt

©2005 IBM

+« Use'AT command... or some other scheduler program/wizard
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Add the Silent Install response file to the AT “Command” step
-10/|

Microsoft Windows 2000 [Version 5.88.21%51
{C> Copyright 1985-200@ Microsoft Corp.

C:xoNsmyiseries'mysharestailorUSR2\setup.exe —s —fiz\myiseries\mysharestailorUSR|
2\mytailored.iss

Microsoft Winfows 2008 [Uersion 5.88.21%5]
<G> Copyrigh 1985-2888 Microseft Corp.

C:\>help at
T 3

Schedule the

Silent Install AT [\“compfiternanc] [ [id1 [/DELETE] | /DELETE [AES11
for end [ ZEUYRY:datel,...1 | /NERT:datel....1] “conmand”
1 & Specifies a remote computer. Commands are scheduled on the
users local computer if this parameter is omitted.
i Is an identification number assigned to a scheduled
comnand .
desktop Cancels a scheduled command. If id is omitted. all the

scheduled commands on the computer are canceled.
Used with cancel all jobs command when no further
confirmation is desired.
Specifies the time when command is to run.
Allows the joh to interact with the desktop of the user
who is logged on at the time the job muns.
Runs the command on each specified day{s) of the week or
month. If date is omitted. the current day of the month
is assumed.
Runs the specified command on the next occurrence of the
day <for exanple, next Thursday>. If date is omitted, the
current day of the month is assumed.

“'command"’ Is the Windous NT command. or batch program to be run.

© 2005 IBM Corporation It S Slmp|e

Control user of
iSeries Access
for Windows

programs/func
tions through:

*Application
Administration

*Microsoft
Policies

© 2005 IBM Corporation Why
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Control Access to iSeries Access for Windows

Policy Administration Applications Administration

- Based on Microsoft System Policy » Based on OS/400 user profiles -- thus
support supports users and groups

» PC user has one set of policies for * User profile can roam with user (from
connectivity to all iSeries servers any PC)

= Can set policies on a specific PC as » A user can have different profiles for
well as users and groups different iSeries

« Can be used to 'configure' as well as « Can restrict usage of Operations
restrict functions Navigator functions, Client Access

« Over 150 policies available! functions, APIs available for use by

« Uses Microsoft System Policy Editor other plug-ins

and Client Access Policy templates : CE;?Jsly-to—use Operations Navigator

The iSeries Way...

» Preferred method for those who want
to control access via OS/400 user
profiles

The Microsoft Way...

« Preferred method for those familiar or
already using Microsoft System
Policies

©2005 IBM Corporation Why " it's S|mp|e.
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Using Policies: Get the Microsoft System Policy Editor
. ' |
Go to Microsoft web page . a rod | ) droer
and download and install [ | ke ::“'*‘w §
“Office XP Resource Kit” || @ rermies [ et | 5 e e s
~ http://www.microsoft.com/ "3 o (4 ~ - ===
windows/default.mspx : ;:.::H ::;::::::mvw <SS
— Search on ‘download system || 3 ssescmes 5 s | £ Padage Oefiton Fles
policy editor’ N £ rofie vawd
My Removsl wisd
@ Setuo P Customzation Wiard

The Microsoft System Policy
Editor is in the Office XP
Resource Kit

— To find it click:
Microsoft ® System Policy Editor
¢ St_art 9 Prog_rams 9 Version 5.1 (Build Zwﬂng 040919-1003 : Service Pack 1}
* Microsoft Office Tools > oLt =151 2 Eici Crpadin
° MicrOSOﬂ ofﬁce XP This preduct is licensed under the temms of the Cod-Lser
Resource Kit Tools > License Agreement to
H i IBM_USER
System Policy Editor o
Physical memory available to Windows:  1.047.472 KB
Note: Get the Policy Editor which
matches your Windows Operating
System

©2005 IBM Corporation Why “i"? it's Simple.

26



IBM eServer iSeries ﬂ
Create iSeries Access for Windows Templates

Creat_e iSeries A<_:cess B Crmimand Promt (¥
for WIndOWS PO“Cy (C)> Copyright IBM Covporation and Others 1984, 20@3. A1l rights pegerved. l

I.8. Government Users Restricted Rights - Use, duplication or disclosure
Templates that can be restricted by GSA ADP Schedule Contract with IBM Corp.

Materials - Property of IBM

used with the Microsoft
: cubadgen [/ps {fileMame>] [/cfy {FileName}1 [/std]

System Policy Editor

— Run iSeries Access for

) icubadgen /ps §1034345
Windows CWBADGEN

Generates per-cysten template for system $1@34345.

utility to create the Output filenane is §1034345.adn
templates cubadgen /std
— CWBADGEN is in Generates caecfg.adn, caeinsrt.adm, and caerestr.adm
Program cubadgen /cfg config.adn
Files/IBM/Client Generates info to configur and environments from
existing configuration inf . Output filename is
Access path config. adn

C:\Program Files\IBM\Client Accesslcwbadgen /std

— On a DOS prompt, run
CWBADGEN /std to
create the templates

© 2005 IBM Corporation Why .--? it's Simp|e.
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Create Policies (example PC5250)
Start Microsoft System Policy
Editor and from toolbar select:  |% Default User Properties
1. Options - Policy Editor > Add Policies |
— Go to the Program + @ OLE DE Frovider ]

Files/IBM/Client Access directory + @ NET Data Provider

and select the caerestr.adm file
that was created by CWBADGEN
utility and add it to the Microsoft
System Policy Editor list

revent configuration of display sessions
Prevent corfiguration of printer sessions
Prevent usage of PC5250 Emulator
Prevent changing of WS profiles
Prevent menu configuration

Prevent toolbar configuration

Prevent mutti-session configuration
Prevent keyboard configuration

2. File > Open Registry - Local TmErimTe s v

User (I 1 | |>]

* Double click on the IBM iSeries
Access Runtime Restrictions
template

» Select PC5250 emulation and set
the restrictions you wish to

impose, then click OK. Cancel

© 2005 IBM Corporation Why “"? it's Simple.

= E E E E E E E




IBM eServer iSeries

PC5250 Restriction Options

 Prevent usage of PC55250 emulator
-  Prevent configuration of display sessions
 Prevent configuration of printer sessions
» Maximum number of PC5250 sessions
mmm) - Prevent changing of .WS profiles
» Prevent menu configuration
» Prevent toolbar configuration
» Prevent multi-session configuration
mmm) - Prevent keyboard configuration
» Prevent mouse configuration
» Prevent JavaTM applet execution
» Prevent access to macros
* Prevent profile imports in Emulator Session Manager
* Prevent profile deletion in Emulator Session Manager
 Prevent directory changes in Emulator Session Manager

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Centrally Manage 5250 Use

Let's say you would like
to control:

» What the users can do with
PC5250

— Number of sessions they
can start, systems they can
connect to, change
keyboard mappings, etc

* Manage all of this on your
server so you could change
something in a single
location and make it
available to all users

© 2005 IBM Corporation Why i"? it's Simple.
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PC5250 Enhancement — V5R1

Can have multiple 5250
sessions with just one .WS
profile

— This gives you ability to: Shared _—
» Set up and manage the Diector

iSeries servers your users WS profile

connect to stored in

* Make all 5250 workstation here
sessions look identical

— Screen settings
— Keyboard

* When you make a change to
these profiles, it will
automatically be made for all
users See Appendix A for
directions on how to
do this

© 2005 IBM Corporation Why .i-? it's Simp|e.

IBM eServer iSeries

Steps to use the shared .WS profile concept

1. Set up ashared directory and give all users ‘read only’
access to it

2. Use Session Manager to configure the
connections/sessions for your users and save these
Profiles in your shared directory

3. Install iSeries Access for Windows and PC5250 on each
user’'s PC

4. Go into iSeries Access for Windows Properties and set
each users PC5250 default path to point to the shared
directory you created.

©2005 IBM Corporation Why “i"? it's Simple.
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Store Profiles on Server

Go into iSeries Access for Windows,
select ‘Emulator’, then select to
Start or Configure Session

— This is called the Session
Manager. It enables you to:
» Start a new session
* Configure a new batch session
» Start an existing session

— Select ‘New Session’

* Now configure the
sessions/connections that you
wish to provide to your users.

» Save them in your shared
directory

© 2005 IBM Corporation

IBM eServer iSeries

At the User’'s PC

o Personl Commicatiors - Sev lager iBER
B
o & =]
mre Farie bonn
i Seaem
i ke S

why “i"? it's simple.

Set PC5250 to look for 5250 emulator files on shared directory

Bring up iSeries Access for
Windows Properties and select
the PC5250 tab

« Copy any files stored in the
\Private folder to your shared
directory

* Change the default from the
iSeries Access installation
directory to User specified path

e Then put in server address that all
your users have read-only access
to

This needs to be done for every iSeries Access
for Windows user. If more than one user on a
single PC, use CWBCFG command from a
DOS prompt to change path for all users.

© 2005 IBM Corporation

o LY .
—=ave
Gl | Pasweds | AdwnsonSpten | laguge |
Incoming Remote Commend | Diagnostic Tools | Senvice FC5250 | Other |
- Path to PC5250 emulator files
" iSeries Acoess installation directory
My Documents
& User specified path
W\MYISERIES\PC5250 PROFILES Browse.
- PC5250 workstation profile to use from iSeries Navigator
 Default profils
 Custorized profile
I Brobuse,
- PC5250 workstation profile migration options
| utomatic migrtion &
] | |

why “I"? it's simple.
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At the User’s PC

g =
Go back into the Session Manager Wl
o o =]
Eol

— Start > Programs - iSeries

. .|

Access for Windows, select -

‘Emulator’, then select to Start !
NS | |

or Configure Session

— Put the sessions you want the
user to have access to on the
user’s desktop

© 2005 IBM Corporation Why "i"? it's Slmple.
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Menu-Bar Customization Utility

* Use Menu Bar B8 convertMacro M@ Emulator
Customization Utili ty Menu-Bar Customization Utility g Programmer’s Toolkit »
P . (& Multiple Sessions Service »
to el iminate th eitems Start or Configure Session AFP Workbench Viewer
you don’t want users B, Trace Fadity 80 Data Transfer From iSeries Server

to be able to perform. e e e

— For example, disable
users’ ability to
create “new”
connections, remove
Properties...

* When you are
finished, store this
also in your shared
directory

©2005 IBM Corporation Why “i"? it's Simple.
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types of menu items:

start the session.

How to delete menu items

To delete menu items, do the following:

2. Click File -> Open.

The Open WorkStation Profile window appears.

3. Choose the profile and click OK.

The menu items appear in the Menu and Items list boxes

4. Choose a menu item to be deleted.
5. Click Delete.

7. Click Exit.

© 2005 IBM Corporation
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Still in the System Policy
Editor

» Select File 2 Save As

* Save the Policy Files you just
created on a shared directory that
each PC user has read only access
to

— The file getting saved has a
.POL file extension.

© 2005 IBM Corporation

+ - Amenu bar command, such as File, Edit, View, and Help. . )
- A pulldown menu command, such as New, Open..., Color Mapping, and Configure.
« - A separator line that resides between two commands in a pulldown menu.

Notes: Menu-Bar Customization Utility

This utility enables you to remove items from the menu bar of the Personal Communications session window; the changes affect
only the session that you customize, so you can make different changes to each session. You can remove the following three
The instructions to modify the menu bar are saved in the workstation profile that you choose and become active next time you

Note: If you want to delete all menu bar commands, do not use this utility. If you use a workstation profile which has no menu
bar commands, no less than one menu bar command will appear. Instead, deselect View -> Menu from the session window.

1. Select the Menu-Bar Customization Utility from the IBM Personal Communications -> Utilities folder.

The menu item which you chose is removed from the list box. If you accidentally delete the wrong item from the either the
Menu or Items list, click Default---this restores all the default menu selections for the profile.

6. Repeat the previous two steps until you have deleted all the menu items you want.

why “i"? it's simple.

Store Policies on a Shared Directory

—
£ System Policy Eitor - W Presentations._for_COMHON\CONHON_2005_SpringZ005 iSeres Access for ... = |0

e Bt Yew Oofors Hep

DjZ|E #&EX

4 :
et DefaiCser:
Computer

e

ienties

why “I"? it's simple.
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Get address of .POL file on every PC desktop

When Windows is started, it needs
to load the policy information to
put into effect before completing
its boot-up.

Provide Windows with the location
where the policy file is stored.

» Use the iSeries Access for Windows
CWBPOLUZ.exe command to to tell
Windows where the policy file is
stored.

— Download this command from
http://www.ibm.com/eserver/
iseries/ access/cadownld.htm

© 2005 IBM Corporation
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How to get CWBPOLUZ.exe to run
on every PC
— Manually run this command on
each PC when you are setting it
up
e This could be directly at the PC
= Or you could Log onto the PC
remotely
— Use iSeries Access for Windows
Incoming Remote Command to
get this command run on
remote PCs

— REXEC, etc

why “i"? it's simple.

Application Administration Overview

* Manage access to functions on
a "per iSeries user" basis

— iSeries Navigator

— iSeries Access for Windows
functions

— Other client and host applications

— Ability to even restrict users with
All Object privilege

» Easy to use interface

* *SECADM authority required on
iSeries to manage Application
Administration settings

— *ALLOBJ required for some
Advanced Settings

© 2005 IBM Corporation
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Application Administration

Eile Edit Wiew Help

SRR XE | wEe 1 minutes old

| Environment: My Connections | Commondenwer
@ Management Central [Commandenver) Mame | Description
B8 nne % Basic Operations Manage messages. printer output, printers. and jobs.
: @Work Management Manage active jobs, server jobs, job queues, subsyste
E Canfiguration and Service Dizplay spstem inventory, work. with fives, and collect |
L gement . Ul Network Manage TCP/P and Intemet support,

% Eonfiguration and Service Security Carfigure and manage security.
g‘:xﬁgj a" Uszers and Groups Manage 057400 uzers and user groups,
Users and Groups B Databases Ldmirister DB2 DB for i5 eries.
IS Dalabases Dt'u File Systems Wik with file systems,
u‘é‘. File Systems Backup Schedule backups of server data.
@ Backup @Apphcation Development ‘wiark with application development taols.

@) Application Development

# Configure connection security and perf
B Change your server password
Bl view syster status

! Add & connection
& Install additional components

8 Fun

a command |Displa_vs the i or licati ilable to v
@ Instal additional companents B
[1-10 of 10 objects [ 4

¢ Can access from Task Bar also

© 2005 IBM Corporation why ? it's Simple.
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Application Administration - By User or Group

Individual users and groups can be given more or
less access capabilities Fustomieaceess_myieros Y

" - Function Excel Add n Uploads
Holly Properties - Partition2 | o iSeries Access for Windows
Function deseription: Provides support to upload server data wsing the Data

Transfer Excel Addin.

Lser name: HOLLY [
[ Agosss:
Desoiplion: Haly Smith [ ¥ Default access

¥ Users with all object system privilege

Passward Use same password [ Customized access for users and group:

Aocess olowed
a8 Operators

i
Flemove ¢ |

Previous sign-on: Mever

Sign-on attempts not vald 0 Aocess deniad:

. i O desusr
¥ User must changs password 2t ne sigrvon 488 e
[T oy lient enplcations b shere this password *.@8 Shipping i a8 ltivoll
E-BgY UsersMotinaGroup 7 —I
¥ Enable user for processing
Remiye Mustrmation | [T R | Heln

Groups Personal Capabilties

s Hetoks - Use user or group properties

x| » Capabilities button
1] Cancel Helj
| ' * Applications tab

2005 IBM Corpora
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Application Administration - by system

* Host Applications Disk
* iSeries Navigator \_ management
(including is not

Management Central) available by
default
| oot hcptcssony HotAppkcatins |
Furcion Thlodk Azcoss [ Dbiect Access|Camized Access | -
EHH A5/400 TCPAP UTILITIES =] ]
B QACKUP RECOVERY AND MEDIA SERVICES Y = (w
EH{¥ patafal, CERTFICATE MANAGER [DCH) O =]
1 6v$TEM CERTIFICATE STORE 0 = x
R i S _J OBJECT SIGHING AFPUICATIONS
e Hgatr | Chert Appac ot | Wor Appicaton: | ByALL dRiECT 0 =
| " GE) ACTESS J08 LG OF “ALLORIIOR [u] =
]m B SERVICE (u]} =]
SR TR —r— B L) CLUSTER MANAGEMENT =] =
ue.gémm. g |45 DISK LKITS () (w]
 Message: ) QIBM_OVLP_SERVICE_LFRRMGMT u ] u]
10 e D 2 &) SERVICE TRACE ] o
"&E“" g O3 ausne_eas_pRODUCT = o
S@Buan B - OiEH_ES_GROUP_OF_FUKCS o o .
Ackve Jobt =] . 2
b;::.: E Rrmove Cusinmetion Fatormes
--=n Dutpud Chamams g
vt :
1 by Pk £ _ topioiers_| o] oo | b
BB Contuusion i Senvee B
- Ve B O
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Notes: Registering Applications

Add and remove applications to be administered through Application
Administration

No changes can be made to the "shipped value" for access settings until the application
has been registered to Application Administration

If an application is shown in both lists on this dialog, it indicates the application has been
registered on the iSeries, but there are some administrator functions for this application
that are defined on this client, but are not registered on the iSeries. You can select the
application and press "Add" to register the additional functions.
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Application Administration —iSeries Access

All Application
Administration information
is stored on the iSeries
server, and roams with
users when they use iSeries
Access for Windows on a
different PC

Windows

Application Administration - Rehastdd

iSeries Access for

410k

Can control use of the
following iSeries Access for

W [

Windows functions: B2 Dowrload fiom server
20 GUI Dowrloads

« PC5250 28 seof RTOPCR
. Data Transfer 20 Autostart Downloads
. ODBC &0 Eyeel Add-n Downloads
20 Active! Autamation Downlads

- OLE DB B3 Ipload to server
* Remote Program Calls -g@unacswpon
- iSeries Access for Windows/ s OLEDB Pois

i ;@ Fiemote Command - Command Line

iSeries Navigator commands

jectAccess | Customized Access

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Type of error message end user might receive

Policy Restriction x|

CwBADT003 - ISenes Mavigatar Application
Administration settings prevent Data Transfer [GUI
Downloading] from running or completing. To
change thiz restriction, see wour administratar,

Detailz Histany Log
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Central Settings

functions only

IBM eServer iSeries

Local Settings

* Can reside on any iSeries

Administration prior to V5R2.

They are now called Local
Settings because:

on each server it connects to...

New in V5R2

Local
Applies to iSeries Settings
Access for
Windows

* Were the only type of administrative
settings supported by Application

— Each iSeries maintains its own set of
Application Administration settings.

Application Administration
for iSeries Access for Windows

Central
Settings Yo

Administration

Local Settings

©2005 IBM Corporation why ""? it's simple.

Application Administration - Local Settings

Explore B Rehasiaq
Open B Rehasizs
Customize this Yiew » [ B Rehas194
Connection ta Server » || B Rehastid
——— (| B rchaszmp

Run Command. ..

B Rchasz7d
Send Message. ..

Bl Rchaszd

Users and Groups v || B Rehas44n
Inventory » || B Rehas4s0
Maonitors » || B rchaseas
Fixes » || B Rchasees
Collection Services » || B Rchas?as

Bl Rchasazd
System Statius =

Application Adriniskration Local Settings

Properties

Displays the centrally managed Functions or applications available to users on this syst

— When an iSeries Access for Windows client
accesses multiple iSeries servers, it will
use whatever Local Settings were defined

©2005 IBM Corporation Why “i"? it's Simple.
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Application Administration - Central Settings

e Edt yow tel
B x| @S 162 mirutes old

Central Settings:

« Affect iSeries Access
for Windows properties
that apply to all iSeries
servers that the client
may access.

>

Central settings:
» Can only be used on OS/400 and iSeries Access for Windows V5R2 or later
» One iSeries must be configured as an "Administration System".

* iSeries Access for Windows clients will retrieve central settings from the
"Administration System"

©2005 IBM Corporation Why " it's S|mp|e.
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Example — Central Settings

‘ Application Administration [Central Settings) - Commondenver

Select the functions o applications available to users.

iSeries Navigator ~ Client Applications

Function IDelau\tAc:Ess IAIIEIbEEIA::Ess Customized Access | 2
S M

iSeries Access for windows

. = 5250 Display and Printer Emulatar
Wi ” ap p Iy to a“ 2| Display Session Configuration
o Printer Session Configuration

systems a user 3 PCS250 Enlstor
connects to in this B Dats Tranche
EFE8 Dowrload from server

network 0 GLI Dowrloads ¥ O

23 Use of RTOPCE

80 Autostart Downloads

80 Excel Addin Downloads

2 Activer! Automation Downloads
B3 Upload to server
@ ODEC Support
a3 OLE DB Provider

= - . i
g [
FRiemave Customization

Applications ... | AdvancedSeltings.l 0K Cancel | Help |

K=

IRRKRKRER
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Central Settings - Advanced

Central Settings SUpport Application Administration {Central Settings) - Rchasrjs [ 2] %]
Advanced Settings Select th fuctions or applcations avalable tousers

iSeries Mavigator  Client Applications |
This allows an oA [Default Access  |AllObject Access | Customized Access | =
administrator to cu_stomize e E_?'i;;:;;i?amﬂgﬁ:gEmm
many of the properties (& Display Sesvion Configuation
used by iSeries Access for Eg:;;ﬁ;*;agg:"“ﬂ““m x
Windows, such as: G Data Trarsfer

803 Download from server
28 GUI Downloads
8 Use of RTOPCE

OO000000000RRKR R,

* Defining a set of S0 Autostan Dowrlozds O
environments to be B3 Excel Add+n Downibads

A @ dctive Autamation Downloads |}

used by the client 3 Uplaad to server O

2 Host File Creation O

B2 File Creation Based on Existing S¢ |

« Customize many of the i ;IJ

connection’ service’ Fiemnyve Customization Custorize:

language, and password
Aetvanced Setings . | g oK Cacdl | Hen |

used by the clients
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Example of an Advanced Setting

Connections: Signon information; Performance

mmondenver

= iSeries Access Connections | Passwords Laﬂguagel Ser\rlcel En\rlruﬂmemal
EI"; 'r o I~ Slgnon inforrmation
-3 Groups B | usewindaws username and password, no prompting

& Use default user |0, prompt as needed

Melly

" Prompt every time

" Use Kerheros principal name, na prompting

| Perfarmance
IP address lookup freguency;

1 | ——

Where to lookup remote port

el | Er—

ﬂl [~ Use Secure Sockets Layer (SEL) for connection

g | _remore |
ok | cancel | nen |7
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Example of an Advanced Settings

Application Administration (Central Settings) - Advanced - Commondenver

= igeries Access Cunnechunsl Passwords Languagel Serice Environments |

Prohibit users il Users
.o R, JA0NLABD
from definin 9 JETS -l glgaﬁ&;e&ashviue Al

additional A Server
environments Remove
Rename

Custormize

REermoye CUstamization |

[~ Allow user to define additional enviranments
Add Remove [~ Allow userto add connections to environment

Help |‘-‘|

©2005 IBM Corporation why ""? it's Slmple.
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Identify a “Central” System
Rechasdgb Properties =100
In order to use a “Central System, ST TS T | =7
you must set up a System in the " RdministiEon S5 [ Directory Senices | Sendce | Plugeins
" ini i © Notan adrministration systern
network to be the "Administration
System" & Administration system
System infarmaton
Sean freguency.

1. Start iSeries Navigator and  Evory et ssssion

point to system you want to be £ Nuriber oftays 4

the Administration System 7 administer sers by defaut
2. Right click on the system name customze Adminishaton of Users.. |

and select “Properties”
3. Click the Administration SetInstallation Image Adrinistration Systerm |

System Tab
4. Check “Administration System”

button to set the system as

your Administration System

Caniel Help |?

©2005 IBM Corporation Why “i"? it's Simple.
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Identify a “Central” System (continued)

:chasdob Propertics s 1
on | ucenses | Rest
Diectory Serates | Senice | Pluging
The key of the Central Settings concept € et an suministrason sstum
is to make it transparent to end users. & Ageinistation systam
[ Sysbem informabion
Sean equency.
* You should also set up this system @ Evenychiee seasion
in your iSeries Access for Windows it e: Fs
install image. [ Administar users by dataul
» Select the “Set Installation Image e

Administration System” button to \ '
do this. s Satinstallation Imags Admirswaion System |

* Then any PC user installing iSeries
Access for Windows from this
system will automatically be set up
with this system being their

“Central System” ok |_cones | _vww 7]

This also saves administration costs as this is the only system in your
network where you would need to install iSeries Access for Windows.

— Additionally, in the future, you would only need to apply Service Packs
and new releases to this system.

© 2005 IBM Corporation Why "i"? it's Slmple.

IBM eServer iSeries -t

Set up PCs to know which system is “Central” System

. Incoming Remate Command | Diagnostic Tools | Senvice | PC5250 | Other |
For PCs with code already Gl | Pancs M Sgen | Lgge
installed
Current administration system: LP1164B
Curent administration user: CMINER
* Go to each PC and open up Sean ey ey T
the iSeries Access for ‘ ——

Windows “Properties” panel.
* Go to “Administration U et

System” tab, and set the

system name for the user.

©2005 IBM Corporation Why “i"? it's Simple.
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IBM eServer iSeries

Windows NT
Windows 2000 |1 NS>

Windows XP
Windows 2003

There are 2 user
account types:

— Computer
administrator

Windows
Operating
System
issues

© 2005 IBM Corporation

why “i"? it's simple.

your own password

© 2005 IBM Corporation

=]
F o
Can become a challenge
to administer in a network
Capabilities Computer Limited
Administrator

Install programs and Yes No

hardware

Make system-wide changes Yes No

Access and read all non- Yes No

private files

Create and delete user Yes No

accounts

Change your own picture Yes Yes

Create, change or remove Yes Yes

why “I"? it's simple.
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Install and Service Pack Tips

Difficult to install new products or Service Packs on PCs
with Windows NT/2000/XP/2003 if user does not have
Administrator Authority

If PC set up
To circumvent this problem: with User
Level
Authority,
* ‘Check Service Level’ can be invoked via a scheduler Windows
running under administrator authority to install service locks out file
packs or upgrades replacements

» Steps:
— Sign onto Windows NT/2000/XP/2003 as an administrator.
— Configure NT/2000/XP/2003 schedule service
* On Windows 2000, Control Panel->Scheduled Tasks
— Set check service level properties
— Schedule check service level

© 2005 IBM Corporation Why "i"? it's Slmple.
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Install and Service Pack Tips (continued)

Administrator can set up Access for r
Windows for Silent updates... T P
E Check senvice level o [ =
E Nt chach occass 0 [ P
E Mumber of mrute b0 delay. |-
Instal Options
‘ R —
™ Copy ratsl mage o PC belors inshaling
Im—i' .Iml e
I Prccl s LA sana s mace 5
Tamt | sesmense | semn | Securty | s |

?
|
i
i
;

Need Administrator's userid/password in here

B me | Note: Userid/password must be same on Windows
as on iSeries
et T [ |

©2005 IBM Corporation Why “i"? it's Simple.



IBM eServer iSeries

Summary

Lots of administrative tools to assist you in managing
your network PCs

V5R3 changes

iSeries Access for Windows Install/Upgrade
* Check Service Level
 Install and Service Pack Tips

Install Tools

e Tailored Install

« iSeries Access for Web Download
» Silent Install

Microsoft Policies
iSeries Navigator Application Administration

it's simple

IBM eServer
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Trademarks and Disclaimers

© I1BM Corporation 1994-2005. All rights reserved.
References in this document to IBM products or services do not imply that IBM intends to make them available in every country.

The following terms are trademarks of International Business Machines Corporation in the United States, other countries, or both:

A@O%GI'VBI‘ e-business on demand i5/0S

AS/400e 1BM 0S/400
Rational is of Business i ion and Rational Software Corporation in the United States, other countries, or both.
Java and all J based are of Sun Mi Inc. in the United States, other countries, or both.
Microsoft, Windows, Windows NT, and the Wir of Microsoft C lion in the United States, other countries, or both.

Intel, Intel Inside (logos), MMX and Pentium are trademarks of Intel Corporation in the United States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and other countries.

SET and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC.

Other company, product or service names may be trademarks or service marks of others.

Information is provided "AS IS" without warranty of any kind.

All customer examples described are presented as illustrations of how those customers have used IBM products and the results they may have achieved. Actual environmental costs and
performance characteristics may vary by customer.

Information concerning non-1BM products was obtained from a supplier of these products, published announcement material, or other publicly available sources and does not constitute an
endorsement of such products by IBM. Sources for non-IBM list prices and performance numbers are taken from publicly available i ion, including vendor and vendor
worldwide homepages. IBM has not tested these products and cannot confirm the accuracy of performance, capability, or any other claims related to non-IBM products. Questions on the
capability of non-IBM products should be addressed to the supplier of those products.

All statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only. Contact your local IBM office or IBM
authorized reseller for the full text of the specific Statement of Direction.

Some future Such is not intended as a definitive statement of a commitment to specific levels of performance, function or delivery
schedules with respect to any future products. Such commitments are only made in IBM product announcements. The information is presented here to communicate IBM's current
investment and development activities as a good faith effort to help with our customers' future planning.

is based on and i using standard IBM in a controlled i . The actual or that any user will
will vary depending upon considerations such as the amount of multiprogramming in the user's job stream, the /O configuration, the storage configuration, and the workload processed.
Therefore,
no assurance can be given that an individual user will achieve or i to the ratios stated here.

shown are of i i . Changes may be it in ion models.
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